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Le informazioni contenute nel presente documento non hanno natura contrattuale e possono essere

soggette a modifiche senza preavviso.

Il software descritto nel presente manuale viene venduto con un contratto di licenza. Il software pud

essere utilizzato, copiato o riprodotto in base ai termini e alle condizioni del contratto.

Il presente manuale non pud essere copiato, riprodotto o trasmesso, in tutto o in parte, in nessuna forma,
Su nessun supporto e per nessuno scopo che si discosti dall'utilizzo da parte dell'acquirente, senza

autorizzazione scritta di TEKLYNX Corporation SAS.

©2024 TEKLYNX Corporation SAS,

Tutti i diritti riversati.
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Informazioni su questo manuale

Convenzioni tipografiche

Nel presente manuale vengono utilizzate diverse convenzioni per distinguere vari tipi di informazioni:

e | termini dell'interfaccia, come i comandi, vengono visualizzati in grassetto.

e | tasti sono scritti in maiuscolo. Ad esempio: "Premere il tasto MAIUSC".

e Gli elenchi numerati indicano una procedura da seguire.

¢ Quando accanto a un paragrafo compare la congiunzione -oppure-, significa che & possibile
scegliere una procedura alternativa per svolgere un determinato compito.

e Quando un comando di menu include dei sottomenu, il nome del menu seguito dal comando da
selezionare compare in grassetto. Quindi, "Scegliere File > Apri" significa selezionare il menu

File, quindi il comando Apri.

Informazioni sul prodotto

Alcune funzionalita descritte nel manuale potrebbero non essere disponibili per il prodotto.

Fare riferimento alle specifiche tecniche fornite con il prodotto per un elenco completo delle funzionalita

specifiche del software.



Introduzione

Benvenuto!

Il pacchetto software per l'identificazione automatica che ha appena acquistato € leader sul mercato

mondiale.

Presentazione

Questo software per la creazione delle etichette consente di creare e modificare rapidamente etichette

complesse, integrando tutti i dati elettronici aziendali, garantendo la totale sicurezza di tutti i sistemi.

L'applicazione soddisfa tutti i requisiti di identificazione automatica e si integra perfettamente nel processo

di produzione.

Nel mercato attuale € la soluzione piu facile e intuitiva per tutte le aziende che operano nell'inserimento,

nella raccolta e nella modifica in tempo reale dei complessi dati dei codici a barre.

Descrizione del prodotto

Il prodotto include i seguenti componenti:

e DVD diinstallazione.
e Documentazione completa in formato elettronico.
e Contratto di licenza e scheda di registrazione.

e Una chiave di protezione elettronica (chiave software) o fisica (chiave hardware).

Requisiti di sistema

| requisiti software e hardware per eseguire l'applicazione sono simili a quelli necessari per la maggior

parte delle applicazioni Windows™:

o OPERATING SYSTEM
Windows®11 x64
Windows®10 x86/x64
Windows® Server 2022
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Windows® Server 2019
Windows® Server 2016

e PIATTAFORME VIRTUALI

Necessitano una licenza VM

¢ MEMORIA

RAM da 2GB o piu RAM (raccomandati 4GB - in base al sistema operativo e all'utilizzo).

e Spazio sull'hard disk

Unita disco con almeno 1.5 GB di spazio libero (a seconda delle opzioni di installazione).

e DISPLAY
Scheda video: adattatore display Windows con risoluzione 1024x768 con capacita True Color e

DirectX® 9 (raccomandata scheda conforme a DirectX 11).

e Software compatibili
Microsoft .NET Framework 4.8 (fornito con l'installazione)
Microsoft .NET Framework 7.0.14 Desktop Runtime per Network License Manager (fornito con
l'installazione)

Il lettore dei file PDF (Adobe Acrobat Reader) & disponibile con linstallazione

o Ulteriori requisiti
Diritti di accesso al computer come amministratore durante l'installazione.
Almeno un driver per la stampante installato sul computer
Per le licenze Online & richiesto quanto segue:
- Accesso Internet al server delle licenze
- Le porte 80 e 443 devono essere aperte (proxy, firewall)

- L’autenticazione Proxy non & direttamente supportata per le licenze Online

Nota: Per scongiurare qualsiasi problema di compatibilita, rimuovere tutte le versioni precedenti di questo

software eventualmente installate nel sistema.

Nota: Il file Release_Notes_En.pdf contiene le informazioni piu aggiornate sul software. Tali informazioni

sostituiscono quelle contenute nel presente manuale.
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Installazione
Nota: Prima di installare il software, salvare il proprio lavoro e chiudere tutti i programmi.

Prima di eseguire il programma di installazione, verificare la configurazione del proprio PC.

1. Posizionare il DVD di installazione nel drive appropriato. Viene visualizzata la finestra di
installazione.
Se il DVD non parte automaticamente : Selezionare Start > Esegui , quindi digitare la lettera del

drive del DVD seguita da index.hta (ad esempio: D:\index.hta).

2. Selezionare il prodotto da installare, fare clic sul pulsante Install e seguire le istruzioni che

vengono visualizzate sullo schermo.

Installazione del software

Selezionare la configurazione del programma che si desidera installare, quindi fare clic su Next.

oake in - Setup Wizard *

Per modificare la modalita di installazione delle funzionalita, fare dic sulle icone nellalbero
sottostante,

Descrizione della caratteristica
- | ‘ - | B

Stampanti
Documentazione
Strument

Componenti aggiuntivi
Esempi

La funzionalita spedficata
richiede 139MB sul disco rigido.
Sono selezionate 5 funzionalita
secondarie su 5. Le funzionalita
secondarie richiedono 797ME s...

Installa su:
C:\Program Files (x86) alie el mw e

Ajuto Spazio Indietro Annulla

Prima di eseguire il processo di installazione, assicurarsi di avere i diritti di amministratore locale.
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Protezione della licenza

Il software pud essere protetto grazie a una chiave software (un codice di attivazione) o una chiave fisica

(una chiave hardware).

e La chiave hardware & un piccolo dispositivo elettronico che viene inserito nella porta parallela o
USB del PC prima di avviare il software. Senza la chiave hardware di protezione del software, il
programma viene eseguito in modalita "valutazione". In questa modalita non € possibile salvare e
stampare le etichette.

e La chiave software & un codice che viene richiesto dalla procedura guidata di attivazione quando
si avvia il software per la prima volta o finché si esegue una versione di prova. Se si utilizza una
chiave software di prova, si hanno a disposizione 100 esecuzioni o 30 giorni per provare il

prodotto con tutte le funzionalita disponibili.

Nota: Quando viene avviata I'applicazione, viene visualizzata una finestra di dialogo che fornisce le
istruzioni necessarie nel caso in cui la chiave di protezione del software non corrisponda alla versione del

prodotto di cui si € in possesso.

E necessario innanzitutto eseguire I'installazione del software di etichettatura e quindi attivare la chiave di

protezione o collegarla al computer.

Nota: Se e stata acquistata una licenza di Rete, installare prima la Gestione licenze di rete (Network
License Manager) per installare il server delle licenze. Installare il prodotto su ciascuna postazione. Per
collegare le postazioni alla rete occorre avviare il software in modalita di prova e selezionare

Amministrazione di Rete.

Protezione con chiave software

Dopo aver installato il software per etichettatura, verra avviata I'attivazione guidata che fornisce

indicazioni passo passo per attivare la protezione tramite chiave software.
Attivazione della protezione

Nell'attivazione guidata, selezionare Attiva. Esistono quattro possibili metodi di attivazione: Attivazione

online, tramite chiavetta USB, tramite smartphone e tramite il sito Web.



Guida per l'utente

Nota: Se il computer in cui € installato il software dispone di una connessione a Internet, viene

selezionata automaticamente I'attivazione online.
e Attiva online

Alcune reti aziendali sono protette da un server proxy. In tal caso, & necessario effettuare un ulteriore

passaggio che consente di immettere I'indirizzo IP e di connettersi a Internet

1. Immettere il Numero di serie e la password forniti con il prodotto e fare clic su Avanti.

2. Immettere le informazioni nel modulo Registrazione utente. Fare clic su Avanti.
3. Fare clic su Fine.

Nota: Per le licenze Online € richiesto quanto segue:
- Accesso Internet al server delle licenze
- Le porte 80 e 443 devono essere aperte (proxy, firewall)

- L’autenticazione Proxy non & direttamente supportata per le licenze Online

Nota: Se il computer in cui € installato il software non dispone di una connessione Internet ma se si ha
accesso a un altro computer con connessione a Internet, &€ possibile eseguire I'attivazione tramite
chiavetta USB.

¢ Tramite chiavetta USB

1. Immettere il numero di serie e la password forniti con il prodotto e fare clic su Avanti.

Selezionare Con una chiavetta USB.

3. Selezionare il supporto da utilizzare per I'attivazione (chiavetta USB o disco rigido esterno oppure

unita di rete) e fare clic su Avanti. | file per I'attivazione verranno copiati sul supporto selezionato.

4. Solo per dispositivi USB: scollegare il supporto removibile e collegarlo al computer dotato di
connessione a Internet.

5. Nel computer connesso a Internet, fare doppio clic su USBWizard.exe (situato nella directory
radice del supporto). Verra avviata |'Attivazione guidata.
Selezionare le licenze da attivare e fare clic su Avanti

Immettere o modificare le informazioni nel modulo Registrazione utente. Fare clic su Avanti.

Se invece é gia stato registrato, procedere alla fase 8. Apparira un messaggio che comunica che i

dati di attivazione per le licenze selezionate sono stati recuperati correttamente.
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10.
11.
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Solo per dispositivi USB: scollegare il supporto removibile dal computer e ricollegarlo al
computer in cui € installato il software.

Nel computer in cui € installato il software, fare di nuovo doppio clic su USBWizard.exe (ubicato
nella directory radice del supporto). L'Attivazione guidata visualizzera la licenza attivabile sul
computer sul quale € installato il software.

Fare clic su Avanti.

Fare clic su Fine.

Nota: Se non si ha accesso a un computer dotato di connessione a Internet, &€ possibile attivare ilprodotto

tramite smartphone.

Tramite smartphone

Per leggere il codice a barre che consente di attivare il software tramite smartphone & necessaria

un'applicazione di scansione dei codici a barre, da scaricare dal negozio / punto vendita dell'applicazione.

Questa modalita di attivazione sfrutta la connessione a Internet dello smartphone.

® N o o bk~ 0w b=

10.

11.
12.

Immettere il Numero di serie e la password forniti con il software e fare clic su Avanti.
Selezionare Con uno smartphone.

Immettere le informazioni nel modulo Registrazione utente. Fare clic su Avanti.

Verra visualizzato un codice a barre. Spostare il cursore sul codice a barre per ingrandirlo.
Aprire I'applicazione di scansione dei codici a barre sullo smartphone.

Scansionare il codice a barre con lo smartphone.

Fare clic su Continua o aprire il browser sul telefono.

Verra visualizzato il sito Web di attivazione del software. Qui & possibile registrarsi e attivare il
software. Compilare tutti i campi.

Fare clic su Inoltra.

Il Codice di convalida e il Codice d'installazione vengono visualizzati in fondo alla pagina Web
di attivazione del software. Se necessario, scorrere verso il basso.

Inserire il Codice di convalida e il Codice d'installazione in maiuscolo durante la procedura
guidata.

Fare clic su Avanti.

Fare clic su Fine.

Tramite il sito Web

Selezionare Con il nostro sito Web.
Il collegamento fornito in questa schermata (http://www.teklynx.eu/nsp/) & raggiungibile da un altro

computer dotato di accesso a Internet. Per completare I'attivazione occorre utilizzare un computer
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dotato di connessione a Internet per collegarsi al sito Web per I'attivazione. Per utilizzare questo
servizio verranno richiesti numero di serie e password (forniti con il prodotto) e il Codice utente
(visualizzato nella procedura guidata).

3. Immettere i dati dell'utente della licenza nel modulo Registrazione utente visualizzato nel nostro
sito Web. Fare clic su Avanti.
Fare clic su Inoltra.
Il Codice di convalida e il Codice d'installazione verranno visualizzati sul nostro sito Web.
Immetterli nell'Attivazione guidata in maiuscolo e fare clic su Avanti.

6. Fare clic su Fine.

Protezione con chiave hardware

Se si & acquistato il software con una chiave hardware, & possibile scegliere tra una chiave per porta USB
o parallela.

Collegamento della chiave parallela:

1 @ HTH

o o
Chiave “=L_..

Se sulla stessa porta parallela viene utilizzata una stampante, € sufficiente inserirla nella chiave di
protezione del software. In tal caso pud essere necessario accendere la stampante per consentire |l

riconoscimento della chiave di protezione del software.

Collegamento della chiave USB:

Se si utilizza una chiave USB e si dispone di varie porte USB, la chiave pu0 essere inserita in una

qualunque delle porte. Se non si ha a disposizione una porta USB, € possibile utilizzare un hub di

12
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espansione USB. | dispositivi USB sono hot-swap, quindi possono essere inseriti € disinseriti dal bus in

qualungue momento, senza la necessita di riavviare il PC.

Nota: | driver possono essere installati mentre I'applicazione € in esecuzione. Tuttavia, perché le
modifiche abbiano effetto sara necessario riavviare il software per I'etichettatura.

Installazione manuale del driver della chiave

Se si desidera installare manualmente il driver della chiave, seguire questa procedura:

1. Selezionare Start, quindi Esegui.

2. Specificare il percorso:

Inserire [Cartella di installazione del prodotto]\Tools\Dongle\ quindi digitare il seguente

comando: \HaspDinst.exe -i

Nota: Si consiglia di chiudere il software di etichettatura e altre eventuali applicazioni prima di installare il

driver.

Avvio del programma

1. Selezionare Start > Programmi.
2. Selezionare il nome che é stato dato al gruppo di programmi durante l'installazione (come

impostazione predefinita, € il nome dell'applicazione). Viene visualizzata la finestra principale.

Messaggi di errori all'avvio del software
Se all’avvio del software viene visualizzato un messaggio di errore, verificare quanto segue:

e | diritti di amministrazione. Per il corretto funzionamento della chiave, € necessario disporre dei
diritti di amministratore sul PC. Se non si dispone di tali diritti, viene visualizzato un messaggio di
errore all’avvio del software. In questo caso i driver devono essere installati manualmente.

¢ Installazione dei driver. Se si incontrano problemi durante I'installazione o se viene visualizzato
un messaggio di errore all’avvio del software, & necessario installare manualmente i driver.

e La chiave: Verificare che la chiave connessa funzioni con il software per I'etichettatura.

e Aggiornamento del driver: Il driver potrebbe non essere aggiornato. Per aggiornarlo, &

necessario scaricarlo dal sito Web all'indirizzo http://www.aladdin.com/support/hasp/enduser.aspx
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Descrizione della finestra principale

Questa sezione comprende una panoramica generale degli elementi della finestra principale nell'ordine in

cui vengono visualizzati all'inizio di una sessione di lavoro.

La barra dei menu

La barra dei menu contiene le seguenti opzioni: File, Modifica, Visualizza, Oggetto, Origine de dati,

Strumenti, Finestra e Guida.
Per aprire un menu

1. Selezionatelo con il pulsante sinistro del mouse.

2. Quindi scegliete il comando desiderato.

Nota : Per accedere a un comando tramite la tastiera, utilizzare i tasti di scelta rapida. Premere ALT

seguito dalla lettera sottolineata nel nome del menu o del comando.

Lo spazio di lavoro

Lo spazio di lavoro € la parte centrale della finestra, posta fra i righelli e le barre di scorrimento. Contiene
un riquadro che fissa i limiti del documento e include gli oggetti da stampare nonché un'area non

stampabile per inserire annotazioni e oggetti che non si desidera stampare.

10 | ‘20 | |3n ‘ E0]
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=
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Il documento

Quando viene aperta una nuova sessione, il programma visualizza un riquadro nella parte in alto a sinistra
della finestra. Questo riquadro rappresenta i limiti del documento da stampare.

Posizionare all'interno del riquadro gli oggetti necessari a creare il documento.

La barra di stato

Posizionata nella parte inferiore della finestra, la barra di stato visualizza il nome della stampante
selezionata, la porta di comunicazione cui & connessa, le coordinate x e y del puntatore del mouse e le

dimensioni cx e cy dell'oggetto selezionato.

Posizionata nella parte inferiore della finestra, la barra di stato mostra il nome della stampante
selezionata, la porta a cui & connessa, le coordinate x e y del puntatore del mouse, le dimensioni cx e cy

dell'oggetto selezionato e il numero dei giorni di validita rimanenti della licenza.

Printer IP_172.21.160.35 X,y 7.14,24.51 ox,cys 23.95,12,.34 999 days left

Le diverse Sezioni sulla barra di stato sono cliccabili per richiamare le finestre di dialogo appropriate:

e Se un documento & aperto, fare doppio clic sull'area del nome della Stampante per mostrare la
finestra di dialogo delle Impostazioni della stampante.

e Se un documento & aperto, fare doppio clic sull'area del nome della Porta per mostrare la finestra
di dialogo Cambia porta della stampante. Questa azione non & disponibile per il driver delle
stampanti di Windows.

e Se un oggetto & selezionato e non bloccato, fare doppio clic sull'area dell'oggetto per mostrare le
Proprieta dell'oggetto selezionato. Se & selezionato piu di un oggetto, sono aperte le Proprieta
dell'ultimo oggetto selezionato.

e Fare doppio clic sull'area Giorni rimasti per mostrare la finestra di dialogo Informazioni.

Le barre degli strumenti

Questi strumenti consentono di eseguire attivita di routine pit rapidamente rispetto all'uso del mouse.
g S AP I 7

Selezione degli strumenti: Fate clic sul pulsante che corrisponde allo strumento.
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La barra del titolo

La barra del titolo visualizza il nome del software e del documento corrente o "documenton. " nel caso in
cui sia stato creato un nuovo documento. Consente di spostare la finestra dello spazio di lavoro con il

mouse.

La barra degli strumenti di formattazione del testo

Questi strumenti consentono di modificare la formattazione di testo e/o di un paragrafo, ad esempio

modificare il font, la dimensione dei caratteri, le opzioni di stile, I'allineamento e cosi via.

: Arial vl1z ~|B I U|5i

4l

Per modificare la formattazione:

1. Selezionare un oggetto nel documento.

2. Fare clic sulle opzioni desiderate.

Nota: Tutte queste opzioni sono accessibili anche dalla finestra di dialogo Testo tramite il comando
Oggetto > Testo.

La barra degli strumenti Oggetto

La barra degli strumenti Oggetto visualizza il nome dell'oggetto selezionato e consente di accedere alle
proprieta di tale oggetto.

T Tewt SN E PV R

il
|

41

La barra degli strumenti Visualizza

La barra degli strumenti Visualizza offre diverse opzioni di visualizzazione.

Per modificare la modalita di visualizzazione fare clic sulla modalita desiderata:

Nome dello .
Pulsante Funzione

strumento

Nome Visualizza i nomi delle variabili.
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KX Dimensione Visualizza la dimensione massima delle variabili.
1z Contents Visualizza i valori delle variabili.
Modulo Visualizza il modulo.
E Visualizza Visualizza le viste Oggetti e Origini dati.
5 v Q a a Zoom Conse.nte di aumentare o diminuire il dettaglio degli
oggetti

Nota: Tutte queste opzioni sono accessibili anche dal menu Visualizza.

La barra degli strumenti di creazione

La barra degli strumenti di creazione include diversi pulsanti che rappresentano ognuno uno strumento

per creare e manipolare oggetti.

Pulsante

'

Nome dello strumento

Selection tool

Funzione

Consente di selezionare e manipolare tutti i tipi di

oggetto.
T- Testo Consente di creare testo fisso e variabile.
(1111183 Codici a barre Consente di creare codici a barre fissi e variabili.
aa]- Immagini Consente di inserire immagini.
RFtag Inserimento oggetto RFTag.
|— Linee Consente di disegnare linee orizzontali o verticali.
. Rettangoli Consente di disegnare rettangoli o quadrati.
O Forme circolari Consente di disegnare forme circolari.
th Figure libere Consente di disegnare figure libere costituite da linee.
/ Linee diagonal Consente di disegnare linee diagonali.
o Rettangoli con angoli Consente di disegnare rettangoli con angoli
arrotondati arrotondati.
IP Figure gia pronte Consente di importare nel documento figure gia pronte.
B Plug-ins Consente di creare campi TextArt / Campo di testo

RTF
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Viste Origini dati e Oggetti

La vista Origini dati visualizza le origini dati e il numero di variabili associato. E possibile inserire gli
oggetti variabile semplicemente trascinandoli nel documento. E possibile inoltre aggiungere, eliminare,

duplicare e modificare le proprieta delle variabili utilizzando il menu Contesto.

La vista Oggetti mostra il numero di oggetti creati per tipo e le relative proprieta come la posizione,
I'altezza e la larghezza. Da questa scheda, & possibile creare un oggetto, selezionare un oggetto e
cambiarne la posizione.

Data sources v X || | @ Objects * X
Database(0) T Text(10)
(5 Date(0) Il Barcode(1)
fx Farmula() Image(3)
When printed() / Line(0)
@ Table lockup(0) (| Rectangle(1)
Counter{() Circle/Ellipseil)
&% Advanced(D) Y Polygen(0)
n Extended chbjects(0)

| tasti con la freccia rivolta verso l'alto e verso il basso consentono di muoversi in su e in giu nella struttura
ad albero. | simboli + e - consentono di espandere o contrarre I'elenco e di visualizzare I'elenco delle

variabili associate a ogni origine dati o gli oggetti disponibili per ogni categoria.
Informazioni sulle origini dati
Una origine dati contiene una lista di variabili costituita da dati con la stessa origine.

Quando si seleziona una origine dati, si indica il tipo e la posizione del dato richiesto. | dati possono
avere origine interna (Data, Contatore) o esterna all'applicaizone (Database, inserimento dati
diretto tramite il Modulo).

Le varie origini dati disponibili nella vista Data Sources sono le seguenti: Database, Data, Modulo,
Formula, Ricerca in tabella, Contatore e Libera.

18



Scoperta dell'interfaccia

Righelli

I righelli vengono utilizzati per visualizzare la posizione del mouse e per posizionare accuratamente i vari
oggetti nel documento. Possono essere impostati in pollici o millimetri utilizzando il comando Strumenti >

Opzioni.

I righelli consentono di individuare la posizione del puntatore del mouse e posizionare con assoluta
precisione gli oggetti da includere nel documento. Possono essere configurati in pollici o millimetri

utilizzando il comando Strumenti > Opzioni > Visualizza.

o Facendo doppio clic sulla parte sinistra del righello orizzontale si riduce la percentuale di
visualizzazione.

e Facendo doppio clic sulla parte destra del righello orizzontale si aumenta la percentuale di
visualizzazione.

e E possibile visualizzare il menu di scelta rapida Zoom facendo clic con il pulsante destro del

mouse sul righello verticale.

Pulsante di rotazione

Se si fa clic su nella parte in alto a sinistra del documento € possibile ruotare il documento stesso di
90°, 180°, 270° o 360° sullo schermo. La rotazione a schermo & una funzionalita esclusivamente di

visualizzazione, non ha alcun effetto sulla stampa.
Per ruotare un documento:

e Fare clic sul pulsante di rotazione con il mouse e ruotare il documento di 90° verso sinistra.
e Fare clic sul pulsante di rotazione con il pulsante destro del mouse e ruotare il documento di 90°

verso destra.

Nota: Lo stesso effetto di rotazione del documento puo essere ottenuto utilizzando il comando View >
Orientation o facendo clic sul righello verticale con il pulsante destro del mouse per visualizzare il menu di

scelta rapida.
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Scelta della stampante

Prima di iniziare a creare un documento, & necessario impostare I'ambiente di lavoro.

Il primo passo consiste nel selezionare la stampante con cui si desidera stampare le etichette. Le
stampanti non hanno tutte le stesse caratteristiche, di conseguenza sono disponibili opzioni diverse a

seconda del modello di stampante scelto.

La seconda fase consiste nell'impostazione delle opzioni dell'ambiente di lavoro, ad esempio la lingua

dell'interfaccia, I'unita di misura ecc. Tutte le opzioni disponibili verranno esaminate piu avanti nel capitolo.

La fase finale consiste nell'impostazione delle pagine dei documenti, ad esempio nella definizione delle

dimensioni del documento, dell'orientamento, dei margini ecc.

Il software di creazione delle etichette consente di stampare con un'ampia gamma di stampanti i cui driver
sono forniti con il software. E inoltre possibile stampare con una stampante Windows installata in locale

sulla macchina o sulla rete aziendale.

E necessario selezionare la stampante prima di iniziare la creazione del documento in quanto la scelta
della stampante determina la configurazione delle opzioni di pagina, I'uso di diversi font di carattere e cosi

via.
Selezione di una stampante
E possibile accedere alla finestra di dialogo Printer selection tramite:

Il comando File > Seleziona stampante

-oppure-

Facendo clic sul pulsante !‘3
-oppure--

pressione del tasto F5.
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Stampanti di Windows e stampanti native

Come abbiamo gia visto, il software di creazione delle etichette & in grado di stampare su un'ampia

gamma di stampanti di Windows e native, sia dirette che a trasferimento termico.

Il termine stampante di Windows fa riferimento a qualsiasi stampante installata sul sistema operativo,
generalmente si tratta di stampanti per ufficio, laser e cosi via. | lavori di stampa vengono inviati allo

spooler (coda processi).

| driver per le stampanti native e a trasferimento termico vengono forniti con il software di creazione delle

etichette. La stampa su queste stampanti viene gestita direttamente dal software.
Per selezionare una stampante

1. Scegliere File > Seleziona stampante.

E anche possibile fare clic sul pulsante !‘E’ o premere F5.

Selezionare una stampante dall'elenco.

Fare clic su OK.

Nota : | driver forniti dall'applicazione sono caratterizzati da un'icona ':-% .

Aggiunta di una stampante

E possibile accedere alla finestra di dialogo Installazione stampante tramite il comando File > Seleziona

stampante, e facendo clic su Aggiungi.

Questa finestra di dialogo consente di aggiungere i driver della stampante forniti con il software.

Nota: Per aggiungere una stampante di Windows, & necessario utilizzare il Pannello di controllo.
Per aggiungere una stampante:

1. Fare clic su File > Seleziona stampante.

E anche possibile fare clic sul pulsante !3 o premere F5.
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2. Fare clic su Aggiungi.
3. Selezionare un tipo e quindi un modello di stampante dall'elenco Modello.

4. Selezionare la porta di comunicazione (seriale, parallela o file), quindi fare clic su OK.

Nota: Fare clic sul simbolo (+) accanto al tipo di stampante per visualizzarne i vari modelli.

Le porte di comunicazione

Nome .
Funzione
porta
.y Indica le porte di comunicazione seriali. Selezionare il numero della porta seriale cui la
X
stampante & connessa.
LPT Indica le porte di comunicazione parallele. Selezionare il numero della porta parallela cui
X
la stampante € connessa.
File Selezionare File se si desidera stampare su file.

Esempio: Aggiunta di una Zebra 140 su LPT1

1. Scegliere File > Seleziona stampante.

2. Fare clic su Aggiungi.

3. Dall'elenco Modello selezionare il gruppo Zebra, quindi b.

4. Selezionare la porta di comunicazione LPT1, deselezionare la casella Direct access, quindi fare
clic su OK.

Personalizzazione dell'ambiente di lavoro

Il software offre numerose opzioni di personalizzazione dell'ambiente di lavoro.

Tali opzioni includono la scelta della lingua dell'interfaccia, dell'unita di misura, delle cartelle di lavoro e del

tasso di conversione delle valute.

Modifica della lingua dell'interfaccia

L'interfaccia utente & disponibile in diverse lingue e pud essere modificata con facilita.

Scegliere Strumenti > Opzioni.
Fare clic sulla scheda Visualizza.

Selezionare la lingua.

Ao =

Fare clic su OK.
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Nota : Quando si fa clic su OK, tutti i menu, i comandi e i messaggi a video verranno visualizzati nella
lingua selezionata (fanno eccezione la guida in linea e le finestre di dialogo di Windows, come Apri e

Salva con nome).

Modifica delle opzioni di visualizzazione e dell'ambiente di lavoro

E possibile modificare la lingua dell'interfaccia, I'unita di misura. Per modificare queste opzioni, utilizzare

la scheda Visualizza.

Per accedere alla scheda Visualizza, selezionare Strumenti > Opzioni.

Scelta dell'unita di misura

L'unita di misura pud essere millimetri o pollici. L'impostazione dell'unita di misura modifica i righelli.

Scegliere Strumenti > Opzioni.
Fare clic sulla scheda Visualizza.

Selezionare l'unita di misura desiderata.

e bh =

Fare clic su OK.

Modifica della scala delle griglie

La scala delle griglie, utilizzata per allineare gli oggetti, pud essere modificata o disabilitata.

1. Scegliere Strumenti > Opzioni.
2. Fare clic sulla scheda Griglia.
-oppure-
Fare doppio clic sul righello verticale per accedere direttamente alla scheda Griglia.
Selezionare la scala desiderata.
Fare clic sull'opzione Visualizza.

Fare clic su OK.

Nota : L'unita di misura utilizzata per la scala delle griglie viene definita nella scheda Visualizza.

Definizione del tasso di conversione

Il tasso di conversione definito nella finestra viene utilizzato nelle formule eurotocurrency (daeuroavaluta)

e currencytoeuro (davalutaaeuro).
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1. Scegliere Strumenti > Opzioni.
2. Fare clic sulla scheda Altre.

3. Immettere il tasso di conversione nella finestra.

Note: Il tasso di conversione predefinito € tra il franco francese e I'euro.

Definizione della cartella di lavoro

La prima volta in cui vengono aperte le finestre di dialogo Apri e Salva con nome dopo aver avviato il

software, la cartella Documenti viene selezionata come cartella di lavoro predefinita.

Scegliere Strumenti > Opzioni quindi la scheda Cartelle predefinite.
2. Fare clic sulla colonna del Percorso per modificare la cartella di lavoro predefinita.

-oppure-

Fare clic sul pulsante E] e selezionare la nuova cartella di lavoro predefinita. Modificare il

percorso nella colonna Percorso

3. Fare clic su OK.

Impostazione delle pagine: Formattazione di un documento
Formattazione di un documento
I modelli dei documenti vengono creati e modificati nella finestra di dialogo Imposta pagina

Formattare un documento significa impostare le dimensioni della pagina, I'orientamento, il numero di
etichette per riga e per colonna, la dimensione del documento, i margini e la distanza fra le etichette. E

possibile creare i propri modelli di documento e salvarli per un utilizzo futuro.

Nota: Prima di creare un modello di documenti, &€ necessario scegliere il modello di stampante che si

utilizzera per produrre i documenti. Scegliere File > Seleziona stampante.

Definire il formato della pagina nella finestra di dialogo Imposta pagina. Vengono cosi aggiornate le
impostazioni della stampante. Il software non utilizza le impostazioni della pagina definite nella finestra di
dialogo Configura la stampante.
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1. Scegliere File > Imposta pagina.

-oppure-

Fare clic sul pulsante Fﬁ

- oppure-

Clic destro nel documento > Clic su Imposta pagina
-oppure-

Fare doppio clic in un punto qualsiasi del documento

1. Fare clic sulla scheda Etichetta e immettere la dimensione e il numero delle etichette.
Fare clic sulla scheda Pagina e selezionare la dimensione e I'orientamento della pagina.
Digitare i valori desiderati nella scheda Margini. La scheda Modello consente di salvare i modelli
personalizzati.

4. Fare clic su OK.

Nota : Quando i parametri immessi sono incompatibili con la dimensione del modello, viene visualizzato

un messaggio di errore.

Esempio: Creazione e definizione dell'impostazione della pagina per un modello personalizzato

1. Creare un nuovo documento.
2. Selezionare la stampante di Windows generica.
3. Scegliere File > Imposta pagina.

- oppure -

Fare clic sul pulsante Fﬁ
- oppure -
Clic destro nel documento > Clic su Imposta pagina
-oppure-
Fare doppio clic in un punto qualsiasi del documento
4. Fare clic sulla scheda Etichetta e immettere i seguenti valori:
Larghezza e Altezza: 30/30
Numero per etichette:
Per riga: 2
Per colonna: 3
Raggio angolo 0
5. Fare clic sulla scheda Pagina e immettere i seguenti valori:
Page sizing: Dimensionamento automatico
6. Fare clic sulla scheda Margini e immettere i seguenti valori:

Margini:
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A sinistra: 10
In alto: 10
Spazio:
Tra colonna: 5
Trarighe: 5
7. Fare clic sulla scheda Modello e immettere i seguenti valori:
Tipo: Family
Nome: Layout1

8. Fare clic su OK quindi salvare l'etichetta come InstallDinSamples\Forms\TutoriaN\TEST1.

Creazione di una custodia per CD: impostazione della pagina e creazione di un modello
personalizzato
Creare un nuovo documento e denominarlo FRONT.
Selezionare la stampante.
Scegliere Strumenti > Opzioni, fare clic sulla scheda Visualizza e selezionare Millimetri come
unita di misura. Fare clic su OK.
4. Scegliere File > Imposta pagina

- oppure -

Fare clic sul pulsante Fﬁ‘
- oppure -
Clic destro nel documento > Clic su Imposta pagina
-oppure-
Fare doppio clic in un punto qualsiasi del documento

5. Fare clic sulla scheda Etichetta e immettere i seguenti valori:

e Larghezza e Altezza: 120,
e Raggio angolo: 100,
e Numero per etichette:

e Perriga: 1,

e Per colonna: 2.
6. Fare clic sulla scheda Pagina e selezionare i seguenti valori:

o Dimensione pagina: A4,

¢ Orizzontale.
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7. Fare clic sulla scheda Margini e immettere i seguenti valori:

e Margini:
e Asinistra: 40,
¢ Inalto: 10,
e Spazzio:

e Trarighe: 15.
8. Fare clic sulla scheda Modello e immettere i seguenti valori:

o Type: Jaquette,
e Name: CDx2.

9. Fare clic su OK.

Note: La stampante utilizzata in questo esempio € una stampante di Windows™. Se si desidera utilizzare
una stampante termica, & possibile che vengano visualizzati messaggi di errore durante l'impostazione
della pagina. Sara quindi necessario modificare i valori suggeriti nell'esempio poiché, come abbiamo gia

visto, la scelta della stampante influisce su alcune impostazioni.

Eliminazione di un modello personalizzato

Se un modello creato non & piu necessario, & possibile eliminarlo.
Per eliminare un modello personalizzato:

1. Scegliere File > Imposta pagina.

-oppure-

Fare clic sul pulsante G*

-oppure-

Clic destro nel documento > Clic su Imposta pagina
-oppure-

Fare doppio clic in un punto qualsiasi del documento

2. Nella scheda Modello, selezionare il modello dagli elenchi Tipo e Nome.

3. Fare clic sul pulsante Rimuovi.
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Creazione e manipolazione di oggetti fissi

La creazione di oggetti fissi implica l'inserimento di oggetti quali testo, codici a barre, immagini, righe,

rettangoli e cerchi nel proprio commento.

Creazione di oggetti

Si puo creare in modo rapido e veloce un oggetto nel proprio documento (codice a barre, immagine, testo,

disegno, ecc.) usando:

i T-l-&E- & -004G/0% 6 .

e La barra degli strumenti Creazione

- OPPURE -
¢ |l menu Oggetto.
- OPPURE -
o Lavista Oggetti usando il menu di scelta rapida su ciascun tipo di oggetto each object type
&% Objects
T Text(10)
Ml Barcade(1)
Image(3)
/ Line(0)

O Rectangle(1)

(O Circle/Ellipse(0)

('Y Polygon(0)

n Extended cbjects(0)

Nota: a ciascun oggetto creato viene dato automaticamente un nome dall'applicazione. Quando l'oggetto

viene selezionato, il suo nome compare nella vista Oggetti e nella barra degli strumenti Oggetto.

Si puo creare un oggetto usando una delle seguenti opzioni:

e Creazione in modalita diretta:

1. Fare clic direttamente sull'oggetto che si desidera inserire nel proprio documento.

2. Fare clic sulla posizione in cui si desidera posizionare |'oggetto.

- OPPURE -
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e Creazione in modalita guidata:

1. Fare clic sul pulsante del menu del proprio oggetto. Apparira un sottomenu con I'elenco delle
azioni a cui € possibile assegnarlo (Oggetto fisso, Procedura guidata, Nuova fonte dati, Usa
una fonte dati esistente).

Selezionare I'azione appropriata.

Fare clic sulla posizione in cui si desidera porre I'oggetto.

Modifica di un oggetto

Si pud modificare un oggetto usando:

e | pulsanti sulla barra degli strumenti, barra degli strumenti di formattazione, barra degli strumenti
di allineamento, ecc.

e Facendo doppio clic sull'oggetto.

e Facendo clic col tasto destro del mouse sull'oggetto e selezionando Proprieta.

e Nella vista Oggetti, facendo clic col tasto destro del mouse sull'oggetto e selezionando Proprieta.

Creazione di un oggetto di testo

Un oggetto di tipo testo pud essere costituito da un carattere, una parola o un intero paragrafo.

E possibile definire lo stile del carattere e il formato del paragrafo utilizzando la barra degli strumenti di

formattazione del testo oppure la finestra di dialogo Testo.

Per creare un oggetto di testo:

-

1. Dalla barra degli strumenti Creazione, fare clic sullo strumento Crea testo T
- oppure -
Scegliere Oggetto > Testo.

2. Fare clic all'interno dello spazio di lavoro oppure sul testo da modificare.
- oppure -
Selezionare e trascinare un riquadro nello spazio di lavoro.

3. Immettere il testo. E possibile definire lo stile del testo utilizzando la finestra di dialogo Testo.
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Nota: € possibile inoltre creare un oggetto dalla vista Oggetti: fare clic col tasto destro del mouse sul tipo
di oggetto desiderato, selezionare I'azione desiderata e fare clic sulla posizione in cui si desidera

posizionare I'oggetto nel documento.
Per aprire la finestra di dialogo Testo:

Scegliere Oggetto >Testo.
- oppure -

Premere il tasto F7.

Creazione di un oggetto codice a barre

Il software offre un'ampia gamma di simboli adatti alle esigenze del settore, nonché la possibilita di creare
codici a barre a 2D.

La selezione dei simboli, la definizione dei rispettivi attributi e I'immissione del messaggio da codificare
avvengono tramite la finestra di dialogo Barcode.

Per creare un oggetto codice a barre:

1. Nella barra degli strumenti Creazione, fare clic sullo strumento Crea codice a barre |""|"| b
- oppure -
Scegliere Oggetto > Codice a barre

2. Fare clic all'interno dello spazio di lavoro.

Si apre la finestra di dialogo Codice a barre.

3. Dalla scheda Codice, selezionare il codice a barre desiderato. E possibile scegliere fra
Stampante e Grafica.

4. Fare clic su Stampante per visualizzare I'elenco dei codici a barre disponibili nella stampante.
- oppure -

fare clic su Grafica per visualizzare I'elenco dei codici a barre generati dal software.

5. Se necessario, specificare le caratteristiche del codice a barre (altezza, larghezza barra stretta,
rapporto, carattere di controllo).
6. Immettere i dati da codificare nella finestra Dati.

Fare clic su OK.
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Nota : Alcune stampanti non dispongono di codici a barre. Ciononostante € possibile stampare codici a
barre tramite I'opzione Grafica. In questo modo pero il funzionamento della stampante € molto rallentato

in quanto i codici a barre vengono inviati alla stampante sotto forma di immagini grafiche.

Nota: € possibile inoltre creare un oggetto dalla vista Oggetti: fare clic col tasto destro del mouse sul tipo
di oggetto desiderato, selezionare I'azione desiderata e fare clic sulla posizione in cui si desidera

posizionare I'oggetto nel documento.

Tracciare una linea

Creazione di un oggetto forma Esempio: tracciare una linea
Il software viene fornito con una gamma di strumenti che consentono all'utente di creare etichette perfette.

E possibile disegnare una linea, un cerchio, un rettangolo e cosi via utilizzando il processo descritto in

seguito.

Per tracciare una linea:

1. Fare clic sullo strumento Disegna linea I_ .
- oppure -
Scegliere Oggetto > Disegno >Linea.
Fare clic all'interno dello spazio di lavoro.

Muovere il mouse tenendo premuto il pulsante sinistro.

Nota: € possibile inoltre creare un oggetto dalla vista Oggetti: fare clic col tasto destro del mouse sul tipo
di oggetto desiderato, selezionare I'azione desiderata e fare clic sulla posizione in cui si desidera

posizionare I'oggetto nel documento.

Disegnare un cerchio o un'ellisse

1. Fate clic sullo strumento Disegna cerchio o ellisse O .

Scegliete Oggetto > Disegno >Cerchio.
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2. Fate clic all'interno dello spazio di lavoro.

3. Tenendo premuto il pulsate sinistro del mouse, spostate il mouse in orizzontale fino a ottenere la

forma desiderata.

Suggerimento

* Per ottenere un cerchio, tenete premuto il tasto MAIUSC mentre trascinate il cursore.

* Per disegnare delle ellissi partendo dal centro, tenete premuto CTRL mentre trascinate il cursore.
* Per disegnare un cerchio simmetrico rispetto al centro, tenete premuto CTRL + MAIUSC mentre

trascinate il cursore.

Nota: € possibile inoltre creare un oggetto dalla vista Oggetti: fare clic col tasto destro del mouse sul tipo

di oggetto desiderato, selezionare I'azione desiderata e fare clic sulla posizione in cui si desidera

posizionare l'oggetto nel documento.

Esempio: Creazione di una custodia per CD: disegno di un cerchio

1. Fare clic sullo strumento di disegno cerchio o ellisse.
2. Fare clic all'interno dello spazio di lavoro.
3. Tenendo premuto il pulsante sinistro del mouse e contemporaneamente il tasto MAIUSC,
muovere il mouse orizzontalmente per creare la forma desiderata.
4. Selezionare il cerchio e scegliere Proprieta dal menu di scelta rapida.
5. Fare clic sulla scheda Posizione e immettere i seguenti valori:
Larghezza e Altezza: 20.
6. Fare clic su OK.
7. Selezionare Oggetto > Allineamento > Orizzontale al centro dell’ etichetta per allineare il
cerchio al centro della custodia.

8. Selezionare il cerchio e fare clic sul pulsante Blocca.

Importazione di un'immagine

Il software consente di inserire immagini e loghi aziendali per perfezionare le etichette.

E possibile importare diversi formati: bmp, dib, dxf, emf, fmf, eps, fpx, img, gif, jpg, pcd, pcx, dex, png, rle,

tga, tif, wmf e wpg.
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1. Dalla barra degli strumenti di Creazione, fare clic sullo strumento Importa immagine lz\ B
- oppure -
Scegliere Oggetto > Immagine.

2. Fare clic all'interno dello spazio di lavoro.

Si apre la finestra di dialogo Selezione immagine.

3. Nella scheda Trova file, selezionare I'immagine da importare.
Selezionare il nome del file dell'immagine.

Fare clic su OK.
Nota : Per visualizzare un'anteprima dell'immagine, fare clic sul pulsante Anteprima.

Nota: € possibile inoltre creare un oggetto dalla vista Oggetti: fare clic col tasto destro del mouse sul tipo
di oggetto desiderato, selezionare I'azione desiderata e fare clic sulla posizione in cui si desidera
posizionare l'oggetto nel documento.
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Informazioni sulle origini dati

Un'origine dati contiene un elenco di variabili costituite da dati che hanno la stessa origine. Le origini dati

possono essere suddivise in categorie e sottocategorie ad eccezione dell'origine Database.

Quando si seleziona una origine dati, si indica dove risiedono i dati richiesti e di che tipo sono. | dati
possono avere origine interna (formula, data, contatore) o esterna all'applicazione (database, immissione
diretta, ActiveX).

Le varie origini dati disponibili nella vista o nel menu Origini dati sono le seguenti:

o L'origine dati Data: consente di inserire data e ora.

e L'origine dati Contatore: consente di inserire un valore auto-incrementante.

e L'origine dati Modulo: consente I'immissione di dati durante la stampa.

e |L'origine dati Formula: consente di creare formule all'interno del documento.

e L'origine dati Database: consente di connettersi a un database.

e |'origine dati Ricerca in tabella: consente di aggiungere il risultato delle ricerche effettuate nei
database.

e |'origine dati Libera: origine dati popolata da dati che non sono stati specificati al momento della

creazione. Un'origine dati libera pud essere utilizzata per creare origini dati intermedie.

Creazione di una origine dati

Le origini dati consentono di utilizzare dati esterni all'applicazione, ad esempio dati di calcolo, la data di

sistema del computer e cosi via. | valori associati a tali variabili provengono da diverse origini dati.
E possibile creare una origine dati da:
La vista Origini dati

1. Nella vista Origini dati, fate clic con il pulsante destro su una delle sorgenti di dati.

2. Selezionate Aggiungi dal menu pop-up.
Il menu Origini dati

1. Fare clic sul menu Origini dati.
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2. Selezionare una delle sorgenti dati.

3. Fare clic su Aggiungi.

La barra degli strumenti

1. Fare clic su nella barra degli strumenti.
2. Selezionare la origini dati desiderata.

3. Nel sottomenu, selezionare Aggiungi.
Per ognuna di queste modalita di creazione:

e L'origine dati creata viene visualizzata automaticamente nella origine dati selezionata.

e L'applicazione associa all'origine dati un nome predefinito.
Nota: Non € possibile utilizzare parentesi {} nel nome della variabile.

Nota: Questa procedura si applica a tutte le origini dati, ad eccezione delle variabili create nell'origine dati

Database. Per creare una variabile database, & necessario creare una guery.

o All'origine dati selezionata & possibile aggiungere categorie e sottocategorie, ad eccezione

dell'origine dati Database.

Nota: per creare le categorie e le sottocategorie, fare clic con il tasto destro del mouse sull'origine dati,

quindi selezionare Aggiungi categoria

L'origine dati Database

Comando: Origine dati > Database > Crea/Modifica una query.

L'origine dati Database contiene un elenco di variabili create in base alle necessita. Tali variabili sono

popolate da dati provenienti da query o tabelle ASCII.

Nota : Quando vengono create, le origini dati conservano i nomi dei campi che le popolano. Non &

possibile rinominare le variabili database in quanto sono associate ai nomi dei campi del database.

Nota: Le variabili di database possono essere convertite in variabili di ricerca in tabella, se necessario.

Comando: Origini dati > Database > Converti in ricerca in tabella...
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Creazione di una query

Comando: Origine dati > Database > Crea/Modifica una query.

Selezionare I'origine dati dall’elenco Seleziona una origine dati.

Nota:per una nuova origine dati fare clic sul pulsante Nuova origine dati. Questo consente di
utilizzare la procedura guidata, scegliere tra un'origine dati ODBC/OLEDB o creare una

connessione di origine web (Google Sheets, Microsoft Excel Online, OData Feed).

Come impostazione predefinita, & attivata la modalita di creazione Standard. Tuttavia, per creare la

query, € possibile utilizzare la modalita di creazione Avanzata SQL:

Modalita di creazione standard

Nell'elenco Seleziona una tabella, selezionate la tabella in cui effettuare la ricerca.

L’'opzione Inserisci il nome delle tabelle consente di visualizzare i nomi delle tabelle nell’elenco
dei campi.

Nell’elenco Elementi, selezionate gli elementi che desiderate visualizzare.

Nell’elenco Seleziona campi, selezionate i campi delle tabelle selezionate.

Suggerimento E consigliabile selezionare unicamente i campi utilizzati nell'etichetta, questo per ridurre

gli scambi di dati con il database e quindi aumentare la velocita di elaborazione.

. i . . s
5. Fate clic sul pulsante [ per visualizzare il risultato.

Modalita di creazione avanzata SQL

Selezionate la modalita SQL.

Immettete la query in formato SQL nel campo di modifica.

-oppure-

Fate clic su SQL Query Builder per accedere a Creazione query. Utilizzate l'intuitiva interfaccia
per creare le query del database SQL. Potete creare nuove richieste graficamente oppure

rappresentare graficamente richieste esistenti nelle vostre applicazioni.
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1 5QL Query Builder

4 || Tables
[ Atlergen
|7 Chemicals
[ FrITINGS
[ Food

7] LabelsCustomForms
[ NotAllergen

|7 Nutrition

7] NutritionTranslation

Food2
Reference varchar(235)
Name varchar(255)

Ingredients longchar(’

ORO®O

Language varchar(255)

-

1073741823)

o
B
o

Visibile Espressione

Neme colonna
Food2.Reference
Food2.Ingredients

Tipo crdinamento  Ordinamente  Aggregato

] Raggruppamento  Criteri

O
O

Select Food2.Reference,
Food2.Ingredients
From Food2

E2 Risultato della query

4. Fare clic sul pulsante Risultato della query per visualizzare il risultato.

Le origini dati create hanno i nomi dei campi del database.

L'origine dati Ricerca in tabella

Comando Origine dati > Ricerca in tabella > Aggiungi

L'origine dati Ricerca in tabella contiene un elenco di origini dati che sono state create dall'utente. | valori

dell'origine dati sono il risultato di ricerche condotte all'interno di database diversi da quelli associati al

documento corrente.

Tali ricerche vengono condotte in uno o pit campi di database. | dati vengono estratti da uno dei campi

individuati in un record (chiamato "campo risultato").

Definizione delle proprieta dell'origine dati Ricerca in tabella

Comando: Origine dati > Ricerca in tabella > Proprieta...

1. Selezionare I'origine dati dall’elenco Seleziona una origine dati.
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Nota: Per creare una nuova origine dati, fare clic sul pulsante Nuova... In questo modo sara possibile

utilizzare la procedura guidata oppure scegliere tra una origine dati ODBC o OLEDB.

2. Come impostazione predefinita, & attivata la modalita di creazione standard. Per effettuare una

ricerca in tabella, & possibile anche utilizzare la modalita di creazione Avanzata: SQL
Modalita di creazione standard

Nell'elenco Seleziona una tabella, selezionate la tabella in cui effettuare la ricerca.
Nell’elenco Seleziona il campo risultato, selezionate il campo il cui valore dovra essere

trasferito nella vostra variabile.

Fare clic su E per aggiungere una riga.
Selezionare il campo nella tabella esterna in cui volete eseguire la ricerca.

Selezionare la variabile del documento corrente contenente il valore della ricerca.

© N o o

Fare clic sul pulsante Prove per visualizzare il risultato.
Modalita di creazione avanzata SQL

Fare clic sulla modalita di creazione del formato SQL.
Inserire la query in formato SQL.
-oppure-
Fare clic su SQL Query Builder per accedere a Creazione query. In questo modo potrete
avvalervi di un’intuitiva interfaccia per creare le query del database SQL. Potete creare nuove
richieste graficamente oppure rappresentare graficamente richieste esistenti nelle vostre
applicazioni.

5. Fare clic sul pulsante Risultato della query per visualizzare il risultato nella finestra di dialogo

Query.

L'origine dati Data

Comando Origine dati > Data > Aggiungi

L'origine dati Data contiene un elenco di origini dati che sono state create. Tali origini dati vengono
popolate dalla data di sistema del computer o dalla stampante. Questa origine dati consente di
visualizzare la data e l'orario in un formato definito precedentemente. | valori vengono popolati

automaticamente all'avvio di ogni sessione di stampa.
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E possibile inserire la data e/o I'ora corrente in un documento. E inoltre possibile aggiungere un valore

fisso alla data o all'ora corrente.

Definizione delle proprieta dell'origine dati Data

Comando: Origine dati > Data > Proprieta...

1. Nella scheda Data, selezionare il formato desiderato per la data e I'ora.
2. Il formato della data viene visualizzato nell'area Anteprima.
3. Fareclic su OK.

Esempio: Inserimento di una data

1. Aprire una etichetta.
2. Aggiungere una origine dati Data e denominarla datefab.

3. Comporre la data nella finestra di dialogo Data. E necessario che il formato sia gg/mm/aa. Per
aggiungere dei separatori, immettere il carattere "/" nella casella di testo nella parte in basso a
sinistra della finestra di dialogo, quindi fare clic su Aggiunti.

4. Fare clic su OK.

5. Selezionare la data (datefab) e trascinarla nello spazio di lavoro.Scegliere Testo nel menu di
scelta rapida.

L'origine dati Contatore

Comando Origine dati > Contatore > Aggiungi

L'origine dati Contatore contiene un elenco di origini dati che sono state create dall'utente. Tali origini dati

vengono popolate da dati calcolati dal computer o dalla stampante.

Il contenuto cambia con I'avanzare della stampa, in base a un valore iniziale e a un valore incrementale.

Definizione delle proprieta dell'origine dati Contatore

Comando: Origine dati > Contatore > Proprieta

1. Selezionare il tipo di contatore.
Se si desidera utilizzare un tipo di contatore diverso da quelli visualizzati nell'elenco, scegliere
l'opzione Personalizzato e immettere una sequenza personalizzata.

2. Immettere un valore nella casella Incremento. Per impostazione predefinita, l'incremento &

uguale a +1.
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3. Immettere un valore iniziale nella casella Valore iniziale. Per impostazione predefinita, tale valore
€ uguale a 0.
4. Fare clic su OK.

Beispiel: Erstellen des Zéhlers

1. Offnen Sie ein Label.

Erstellen Sie einen Zahler mit dem Namen namcd.

w

Wahlen Sie diesen Zahler aus, und wahlen Sie anschlieliend im Kontextmen( die Option
Eigenschaften.

Wabhlen Sie Dezimal als Zahlerart.

Geben Sie in das Feld Zahlschritt den Wert "1" ein.

Geben Sie in das Feld Aktuelle Wert den Wert "1" ein.

Klicken Sie auf OK.

Wabhlen Sie den Zahler aus, ziehen Sie ihn in den Arbeitsplatz, und legen Sie ihn dort ab.

© N o o &

Wabhlen Sie im Kontextmenu die Option Texte.
9. Klicken Sie mit der rechten Maustaste darauf, und wahlen Sie im Kontextmen( die Option
Eigenschaften.

10. Wahlen Sie die folgenden Texteigenschaften aus:

e Schriftart: Arial,

e Breite: 3.20 mm.

L'origine dati Formula

Comando Origine dati > Formula > Aggiungi

L'origine dati Formula contiene un elenco di origini dati che sono state create dall'utente. Tali origini dati
vengono popolate da combinazioni di operatori, costanti, variabili, variabili di controllo, formule e funzioni. |

dati possono essere numerici o alfanumerici.
Per effettuare un calcolo all'interno di un documento, & necessario creare una origine dati Formula.

Per questa origine dati esiste una finestra di dialogo specifica che consente di definire le funzioni

necessarie alla formula data.
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Definizione delle proprieta dell'origine dati Formula

Comando: Origine dati > Formula > Proprieta...

1. Immettere la formula direttamente nella casella editing.
_o_

Selezionate con il mouse gli elementi desiderati quindi fate clic su Inserisci.
2. Fare clic su OK.
Suggerimento: E possibile inserire un elemento selezionandolo con un doppio clic.

Nota: Se il nome di una variabile utilizzata nella formula contiene uno dei seguenti caratteri &+-

*/<>="%,\", deve essere racchiusa tra parentesi {}.

Note : Anteprima dinamica che rappresenta il risultato del calcolo della formula corrente, compresa la
formattazione definita nella pagina Output. In caso di errore, I'anteprima viene visualizzata in rosso. Se il
valore ottenuto € troncato, &€ necessario modificare la lunghezza massima specificata nella scheda
Output.

Esempio: Creazione di una formula semplice

Visualizzazione del prezzo di un prodotto

L'etichetta di produzione deve indicare il prezzo del prodotto come funzione del peso e del prezzo al

chilogrammao.

1. Aprire una etichetta con due variabili: WEIGHT e PRICEPERKG.

2. Perla variabile WEIGHT: immettere 788 (assumendo che il peso del prodotto sia 788 g) come
valore Local e immettere "Immettere il peso in g" nella casella Prefix, quindi fare clic su OK.

3. Perla variabile PRICEPERKG: immettere 15,70 (il peso al kg & 15,70 euro) come valore Local
della variabile.

limmettere "Immettere il prezzo al kg" nella casella Prefix, quindi fare clic su OK.
Aggiungere una formula e denominarla Prezzo.

Immettere la formula WEIGHT*PRICEPERKG/1000, quindi fare clic su OK.

N o o &

Salvare il documento.
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Esempio: Aggiunta di una variabile della formula "Avviso"” per la visualizzazione di un messaggio
di avviso.

Nella sequenza seguente, verra creata una formula nell'etichetta PRODUCT_WS3 perché venga
visualizzato un messaggio di avviso che segnali all'utente che il valore della variabile condivisa
Total_Weight supera 1.000 kg.

Se il valore del peso supera i 1.000 kg, viene visualizzato il messaggio "Attenzione! Errore! Il peso totale

supera il massimo consentito!"

1. Aprire I'etichetta
2. Creare una formula e denominarla "Avviso".

3. Nella casella di dialogo Formula, immettere la seguente espressione: if(Total_Weight>1000,
"Attenzione\n!Errore!\n Il peso totale supera il massimo consentito!", "").

4. Nella scheda Output, immettere 50 in Maximum length e fare clic su OK.
5. Posizionare la variabile come testo all'interno dell'etichetta.

6. Nella casella di dialogo Testo, selezionare Scalable come font e impostare il valore di Height a
12,70 mm.

7. Nella scheda Paragrafo, selezionare 'opzione A capo automatico e quindi Centra
(allineamento)

L'origine dati Modulo

Comando Origine dati > Modulo > Aggiungi

L'origine dati Modulo contiene un elenco di variabili che sono state create dall'utente. Tali variabili

vengono popolate immettendo dati direttamente dal Modulo digitando sulla tastiera.

Per visualizzare il modulo

Il Modulo consente di immettere i dati direttamente durante la progettazione o, piu comunemente, prima
della stampa.

Per visualizzare il modulo

1. Aprire I'etichetta contenente una variabile Modulo.
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2. Fare clic sul pulsante nella barra degli strumenti.

Come impostazione predefinita, lo spazio di lavoro consente di visualizzare I'etichetta e il modulo

separatamente.
Per visualizzare I'etichetta e il modulo insieme:

1. Selezionare I'etichetta relativa al modulo.
2. Trascinare la scheda verso l'alto o verso il basso fino a quando il Modulo non viene rilasciato

nella sua finestra. Se lo si desidera, & possibile ancorare la nuova finestra.

-oppure-
1. Selezionare Finestra > Nuovo gruppo schede verticale
Entrambe le viste sono ora visibili.

Tutte le modifiche apportate all'etichetta o al modulo aggiorneranno automaticamente i dati dell'altro.

Personalizzare il Modulo

E possibile personalizzare I'aspetto del proprio modulo modificando il colore, il font e altri elementi nella

finestra di dialogo Impostazioni modulo.
Per accedere alla finestra di dialogo Impostazioni modulo:

e Scegliere Vista > Impostazioni modulo.
- oppure -

e Selezionare il modulo con il mouse, fare clic con il tasto destro del mouse e selezionare
Impostazioni modulo.
- oppure -

o Fare doppio clic sullo sfondo della finestra rappresentata nella vista Modulo (solo in modalita

Modulo automatico) .

Creare un Modulo personalizzato con il Form Editor

Aprire la finestra di dialogo Impostazioni modulo come indicato sopra.

Impostare I'opzione modalita Modulo su Personalizzato e fare clic su OK.
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Accedere al Form Editor:

1. scegliere Vista > Modulo > Modifica modulo...

-oppure-

scegliere Barra degli strumenti Vista > Modulo > Modifica modulo...

-oppure-

richiamare il menu del contesto Modulo > Modifica modulo...

2. Scegliere la Modalita di creazione necessaria nella finestra di dialogo Procedura guidata per la
creazione di un Modulo personalizzato:

2. Converti da Modulo automatico
Consente di convertire facilmente i comandi dal Modulo automatico.
3. Configura i comandi manualmente
Consente di assegnare origini dati ai comandi del Modulo manualmente.
4. Modulo vuoto
Si aprira lo strumento Form Editor con un Modulo vuoto pronto per essere personalizzato.

Nota: qualora un’etichetta non contenga variabili, nella finestra di dialogo Procedura guidata per
la creazione di un Modulo personalizzato € disponibile solo la modalita di creazione “Modulo

vuoto”.

Nota: La Procedura guidata per la creazione di un Modulo personalizzato viene visualizzata
quando il Form Editor viene aperto per la prima volta o reimpostato. In caso contrario, Form Editor

viene visualizzato senza la procedura guidata.

3. Selezionare un comando dalla barra degli strumenti sulla sinistra, quindi fare clic sul Modulo dove

si desidera posizionare il comando.

Il comando appare nel Modulo e le sue proprieta vengono visualizzate nella barra degli strumenti

sulla destra.

E possibile utilizzare il mouse per modificare la posizione e la dimensione del comando.

E possibile modificare le proprieta del comando nella barra degli strumenti.
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La tabella sottostante elenca i comandi disponibili e le loro principali funzionalita.

Controllo

Funzionalita

Inserimento testo

Inserire un valore secondo determinati criteri.

Selezione data

Selezionare una data usando un calendario.

Su/Giu numerico

Selezionare un valore numerico usando le frecce in su/giu.

Casella di controllo

Selezionare uno dei due valori selezionando/deselezionando una

casella.

Elenco pulsanti radio

Selezionare uno dei diversi valori selezionando il pulsante

corrispondente.

Casella degli elenchi

Selezionare uno dei diversi valori selezionando la voce corrispondente.

Selezione record

Selezionare un record da un database.

CEERREEEE

Selezione ora

Selezionare un’ora secondo un formato definito.

-l— |[Cursore Selezionare un valore numerico da un intervallo definito.
— JAcquisizione i o i
>4 | ) Selezionare un file immagine.
immagine
Aa  |Etichetta Visualizza del testo fisso o il valore di un’origine dati.
/ Linea \Visualizza una linea fissa.
Immagine \Visualizza un’immagine fissa o un’immagine definita in un’origine dati.

Casella Raggruppa

Raggruppare i comandi con un bordo e un’intestazione facoltativi.

IAnteprima etichetta

Visualizza I'anteprima dell’etichetta corrente.

Esempio di Moduli personalizzati

Troverai esempi di design di etichette che utilizzano la funzione Modulo personalizzato nella cartella degli
esempi di etichetta.
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Modify the order in which data is entered into the form

Potete modificare 'ordine in cui i dati vengono immessi nel modulo visualizzato.

Procedete come segue:

oo bd =

o

Selezionate il modulo utilizzando il mouse.

Fate clic con il pulsante destro.

Selezionate Avvia pianificazione. Compare la numerazione predefinita.

Fate clic sul numero del campo che volete che compaia per primo nel modulo. Tale campo
diventa verde quando convalidato.

Ripetete il passaggio 4 per continuare a ordinare i campi.

Per confermare la selezione, fate clic sul pulsante destro e selezionate Convalida ordine dati.

L'ordine dei campi verra automaticamente convalidato alla convalida del primo campo. Quindi la

numerazione scompare dal modulo

Nota: potete annullare qualsiasi modifica. Fate clic con il pulsante destro sul modulo e selezionate
Abbandona...

Definizione delle proprieta dell'origine dati Modulo

Comando: Origine dati > Modulo > Proprieta...

Fare clic sulla scheda Modulo.
Immettere il messaggio che si desidera venga visualizzato nel modulo.
Se lo si desidera, € possibile definire un formato di immissione e una lunghezza minima.

E possibile creare valori che verranno proposti nel modulo selezionando <Locale> dalla Elenco

valori. In seguito fare clic su D per accedere alla finestra di dialogo Elenco valori.
Nella scheda Output, & possibile definire un formato di output, una lunghezza massima, un
suffisso e un prefisso.

Fare clic su OK.

Nota : Se viene definito un valore locale vuoto e si seleziona la casella Ripristina dopo la stampa, il

valore della variabile verra impostato su vuoto dopo ogni lavoro di stampa.
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L'origine dati Libera

Comando Origine dati > Libera > Aggiungi

L'origine dati Libera contiene un elenco di origini dati che sono state create dall'utente. Queste origini dati
sono popolate da dati che non sono stati specificati al momento della creazione. Un'origine dati Libera

pud essere utilizzata per creare origini dati intermedie.

Definizione delle proprieta dell'origine dati Libera

Definite le proprieta delle origine dati dalla vista Origini dati.

1. Nella scheda Input,selezionare una delle seguenti opzioni:Locale o Condivisa o A partire da un
file .
Se ¢ stata scelta 'opzione Local, immettere il valore della variabile nella casella. Questo sara il
valore iniziale della variabile, quello che verra stampato per primo.
- oppure -
Se ¢é stata scelta I'opzione Condivisa, immettere il valore della variabile nella casella. Fare clic su
OK.
- oppure -
Se ¢é stata scelta I'opzione A partire da un file, selezionare il file richiesto.

2. Nella scheda Output, & possibile definire un formato di output, una lunghezza massima, un
suffisso e un prefisso.

3. Fare clic su OK.

Esempio: Creazione di una variabile libera

1. Aprire una etichetta.

2. Creare una origine dati Libera e denominarla "ref".

3. Inserire I'origine dati nell'etichetta in formato testo.

4. Per evitare che l'origine dati venga visualizzata nella stampa, selezionarla e fare clic su nella barra

degli strumenti Oggeto.

Creazione di oggetti variabili

Un oggetto variabile & un testo, un codice a barre o un oggetto di tipo immagine costituito da elementi i cui
valori non sono stati definiti al momento della creazione. E possibile associare diversi oggetti a una
singola variabile.
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Il valore di tali elementi viene derivato da diverse origini dati al momento della stampa:

e Immissione diretta dalla tastiera nel Modulo (origine dati Modulo).
e Importazione da file o database esterno (origine dati Ricerca in tabella o Database )

e Calcolo del campo da computer (origini dati Formula, Contatore e Data)

Nota :Nella vista Origini dati, una freccia rossa =* indica la variabile associata all'oggetto selezionato..

Creazione di un oggetto variabile collegato a una origine dati esistente

E possibile creare in modo semplice e veloce un oggetto variabile (codice a barre, immagine, testo,

disegni ecc.) nel documento utilizzando:
e La barra degli strumenti di Creazione,
-oppure-
¢ |l menu Oggetto.

Seguendo le indicazioni fornite, & possibile creare un oggetto utilizzando una delle seguenti opzioni:

e Creazione modalita diretta:

1. Fare clic direttamente sull'oggetto che si desidera inserire nel documento.
2. Fare clic sul punto in cui si desidera posizionare I'etichetta.
La creazione guidata si avvia come impostazione predefinita. In caso contrario, fare doppio clic
sull'oggetto per aprire la finestra di dialogo Proprieta.
Fare clic sulla scheda Origini dati.
Selezionare Variabili.
Selezionare la variabile che si desidera assegnare all'oggetto.

- oppure -
e Creazione modalita guidata (secondo i requisiti di utilizzo):
1. Fare clic sul pulsante del menu dell'oggetto. Viene visualizzato un sottomenu che mostra le azioni
disponibili
2. Per creare un oggetto variabile utilizzando una origine dati esistente, si pud scegliere di:

- Selezionare Utilizzo di una origine dati esistente seguito dalla variabile interessata.
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oppure
- Selezionare Procedura guidata per essere guidati passo per passo nel processo di creazione
dell'oggetto variabile.

3. Fare clic sul punto in cui si desidera posizionare l'etichetta.

Nota: la creazione guidata € abilitata come impostazione predefinita. Per disabilitarla, selezionare

Strumenti > Opzioni > Procedure guidate.

Nota: & possibile inoltre creare un oggetto dalla vista Oggetti: fare clic col tasto destro del mouse sul tipo
di oggetto desiderato, selezionare I'azione desiderata e fare clic sulla posizione in cui si desidera

posizionare l'oggetto nel documento.

Nota:L'opzione di assegnazione degli oggetti Testo/Codice a barre € disabilitata per le variabili di
database e di ricerca in tabella contenenti tipi di dati BLOB (ad esempio, immagini da un database),

pertanto possono essere utilizzate soltanto come origine dati per oggetti Immagine.

Creazione di un oggetto variabile collegato a una nuova origine dati

E possibile creare in modo semplice e veloce un oggetto variabile (codice a barre, immagine, testo,

disegni ecc.) nel documento utilizzando:
e La barra degli strumenti di Creazione,
-oppure-
e Il menu Oggetto.
Seguendo le indicazioni fornite, & possibile creare un oggetto utilizzando una delle seguenti opzioni:
¢ Creazione modalita diretta:

1. Fare clic direttamente sull'oggetto che si desidera inserire nel documento.
2. Fare clic sul punto in cui si desidera posizionare I'etichetta.
La creazione guidata si avvia come impostazione predefinita. In caso contrario, fare doppio clic
sull'oggetto per aprire la finestra di dialogo Proprieta.
Fare clic sulla scheda Origini dati.
Selezionare Variabili.
Selezionare la variabile che si desidera assegnare all'oggetto, fare clic con il pulsante destro del

mouse e selezionare Aggiungere.

49



Guida per l'utente

-oppure-

Fare clic sul pulsante Nuovo, quindi selezionate la variabile da aggiungere.

-OPPURE-

¢ Creazione modalita guidata (secondo i requisiti di utilizzo):

1. Fare clic sul pulsante del menu dell'oggetto. Viene visualizzato un sottomenu che mostra le azioni
disponibili.

2. Per creare un oggetto variabile utilizzando una nuova variabile, & possibile scegliere di:
- Selezionare Nuova origine dati,
oppure
- Selezionare Procedura guidata: per essere guidati passo per passo nel processo di creazione
dell'oggetto variabile.

3. Fare clic sull'ubicazione in cui desiderate posizionare I'etichetta.

Nota: la creazione guidata € abilitata come impostazione predefinita. Per disabilitarla, selezionare

Strumenti > Opzioni > Procedure guidate.

Nota: € possibile inoltre creare un oggetto dalla vista Oggetti: fare clic col tasto destro del mouse sul tipo
di oggetto desiderato, selezionare I'azione desiderata e fare clic sulla posizione in cui si desidera

posizionare l'oggetto nel documento.

Nota:L'opzione di assegnazione degli oggetti Testo/Codice a barre € disabilitata per le variabili di
database e di ricerca in tabella contenenti tipi di dati BLOB (ad esempio, immagini da un database),

pertanto possono essere utilizzate soltanto come origine dati per oggetti Immagine.

50



Stampa

Un potente motore di stampa

Il software &€ uno strumento di creazione potente e semplice da usare e al contempo un motore di stampa
utilizzabile con la piu vasta gamma di stampanti possibile (termiche, a trasferimento termico, a getto

d'inchiostro), mai disponibile finora sul mercato dell'identificazione automatica.

Per qualsiasi lavoro di stampa, una singola etichetta, una serie di etichette o svariate copie della stessa

etichetta, i comandi di stampa sono raggruppati in un unico punto, la finestra di dialogo Stampa.

Inoltre, il software per I'etichettatura consente di installare e controllare le stampanti in qualsiasi punto

della rete.

In questa sezione verranno illustrate tutte le possibili configurazioni di rete e le relative procedure di

installazione per Il'ottimizzazione della stampa delle etichette.

Stampa di una etichetta

Per qualsiasi lavoro di stampa, una singola etichetta, una serie di etichette o svariate copie della stessa

etichetta, le impostazioni di stampa vengono definite tutte nella la finestra di dialogo Stampa.

1. Scegliere File > Stampa per accedere alla finestra di dialogo Stampa.

Ry E w
E anche possibile fare clic sul pulsante =0 premere F6.

2. Nella casella di testo Etichette, immettere il numero di etichette da stampare.
3. Fare clic su OK.
Esercitazione pratica 1 - Etichetta e serie di etichette
Per iniziare, & necessario chiarire la distinzione fra Etichetta e serie di etichette.

Nota: Se I'etichetta non include un contatore, la finestra di dialogo Stampa non visualizzera il

campo Copies of each label, ma solo il campo Labels, che in questo caso avra la stessa funzione.

Per chiarire la differenza fra Etichetta e serie di etichette, verra presa in considerazione
un'etichetta contenente due tipi di contatori e la finestra di dialogo Stampa verra configurata in

diversi modi.
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e Aprire una etichetta .
Creare diversi contatori:
¢ Un contatore classico che conta tutte le etichette e si reimposta quando |l

conteggio raggiunge 10:
e Tipo
¢ Incremento +1
e Valore minimo 0

e Valore massimo 10

* Un contatore ISO che consente la numerazione singola di ciascuna copia delle

etichette. Anche questo contatore si reimposta quando raggiunge il valore 10:
e Tipo

¢ Incremento +1

e Valore minimo 0

Il primo contatore, chiamato NumLabel, identifica un'etichetta particolare mentre il contatore 1ISO

conta il numero totale di etichette stampate.

Etichette in serie

In questo esempio verra stampata una serie di 10 etichette:

1. Specificare i seguenti valori nella finestra di dialogo Stampa:
e Etichette : 10.
In questo modo viene specificato che nella serie saranno presenti 10 diverse etichette.

2. Fare clic su Stampa.

Il risultato della stampa € quello atteso: sono state stampate 10 etichette e i due contatori visualizzano lo

stesso valore.

Copia delle etichette

In questo esempio verra stampata una serie di cinque etichette, questa volta perd verranno realizzate due
copie per ognuna.
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1. Specificare i seguenti valori nella finestra di dialogo Stampa:
e Etichette: 5

e Copia delle etichette: 2.

2. Fare clic su Stampa.

Sono state stampate 10 etichette; tuttavia, il risultato & completamente diverso rispetto a quanto ottenuto

nell'esempio precedente.

Copia di una pagina

Come abbiamo appena visto, & possibile stampare diverse copie della stessa etichetta. Nel prossimo
esempio vedremo che & possibile anche stampare diverse copie della stessa pagina. Per far cio, &

necessario sapere con esattezza che cos'é una pagina per la stampante.

La pagina & determinata dai parametri specificati durante la configurazione del driver della stampante. |
risultati ottenuti possono essere completamente diversi a seconda che si utilizzi una stampante da ufficio
o una stampante termica. Puo essere difficile visualizzare una pagina su carta continua, utilizzata

principalmente dalle stampanti termiche.

Inoltre, in base alle dimensioni del supporto di stampa e dell'etichetta, le dimensioni della pagina possono
corrispondere a quelle dell'etichetta, di conseguenza la copia della pagina pud essere la stessa

dell'etichetta.

Il formato della pagina e la dimensione dell'etichetta vengono definiti nella finestra di dialogo Imposta

pagina.
1. Aprire una etichetta.
2. Selezionare File > Seleziona stampante.
3. Selezionare una stampante per ufficio Windows.
4. MVerificare che il formato della carta sia A4, quindi fare clic su OK.

5. Selezionare File > Imposta pagina o fare clic su R‘
Verra visualizzata la finestra di dialogo Imposta pagina.
L'anteprima di stampa da un'idea di come sara la pagina stampata.

6. Chiudere la finestra di dialogo.
=
7. Fareclicsu T "
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8. Immettere i seguenti valori:
o Etichette: 8
e Copie per pagina: 2

9. Fare clic su Stampa.

Avvio di una unione di stampa

L'opzione di unione & disponibile quando & stato aperto un database di tipo merge. Avvia la stampa delle

etichette, con l'inclusione di tutti i record del database.

1. Scegliere File > Stampa per accedere alla finestra di dialogo Stampa.

-oppure-

. i
Fare clic sul pulsante %#.

Nella casella di testo Etichette, immettere il numero di etichette da stampare.
Selezionare la scheda Database. Nel campo Record, selezionate Tutti i record.

Fare clic su OK.

Stampa con il modulo

Quando il modulo ha l'aspetto desiderato, & possibile avviare la stampa.

1. Selezionare File > Stampa oppure premere il tasto F6.
Immettere "2" nel campo Etichette.
Avviare la stampa.
Il modulo viene visualizzato ed & necessario immettere i dati da stampare.
4. Immettere "Smith" e "51", ad esempio, quindi fare clic su OK.
Una volta stampata la prima etichetta, il modulo viene visualizzato nuovamente.

5. Immettere "Mullang” e "52", ad esempio, quindi fare clic su OK.

Note: Il modulo viene visualizzato per ogni etichetta contenuta nella serie. Se si sceglie I'opzione Per ogni

serie, il modulo verra visualizzato una sola volta, all'avvio della stampa della serie.
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Stampa

La finestra di dialogo Print

contiene differenze...

Quando I'etichetta include un contatore: I'opzione Etichette consente

di specificare il numero di etichette in una serie;

Copia delle etichette consente di determinare il numero di copie della

stessa etichetta da stampare.

Quando I'etichetta non include un contatore, questa opzione ha la

stessa funzione del campo Etichette.

Copia di una pagina

E possibile copiare una pagina solo se I'etichetta non include un

contatore ISO e se la pagina contiene piu di un'etichetta.

Unione di stampa

Questa opzione stampa tutti i record in un database ed & disponibile

solo se l'etichetta € associata a un database.

Stampa con il Modulo

Il Modulo consente all'operatore di immettere i dati dalla tastiera

subito prima della stampa.
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Risoluzione dei problemi

La seguente tabella elenca i problemi che si verificano piu di frequente durante la stampa e offre alcune

soluzioni per aiutare l'utente a risolverli.

Problema
Non viene stampato

niente

Causa

La stampante non & collegata.

Soluzione

Collegare la stampante.

Per un collegamento parallelo:

- La stampante non &
configurata per un
collegamento parallelo.

Assicurarsi che l'impostazione sia stata
configurata nel pannello di controllo della
stampante (fare riferimento al manuale del

produttore).

Per un collegamento seriale:
le impostazioni della
comunicazione seriale non

sono corrette.

Assicurarsi che le impostazioni di
comunicazione tra il PC e la stampante
siano le stesse (per le impostazioni di
comunicazione seriale richieste dalla
stampante, fare riferimento al manuale del

produttore).

Il cavo seriale non & adatto.

Assicurarsi che il cavo soddisfi i requisiti
della stampante (fare riferimento al

manuale del produttore).

In entrambi i casi
(collegamento seriale o
parallelo):

- Il cavo € connesso alla porta

sbagliata.

Verificare la connessione.

In entrambi i casi
(collegamento seriale o
parallelo):

- Il cavo € connesso alla porta

sbagliata.

Verificare la connessione.

Una pagina non

viene stampata

Per la stampa termica: il
supporto di stampa & stato
inserito nel modo sbagliato (la
testina di stampa riscalda il

lato sbagliato della carta.

Reinserire il supporto nel modo corretto.
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Per la stampa a trasferimento
termico: il nastro non & stato
inserito oppure & stato inserito

nel modo shagliato.

Controllare il nastro e riposizionarlo se
necessario (fare riferimento al manuale del

produttore).

La modalita di stampa
richiesta non & stata

selezionata sulla stampante.

Verificare che la modalita di stampa
(termica o a trasferimento termico) sia stata
selezionata correttamente sulla stampante
(fare riferimento al manuale del produttore)
oppure nella finestra di dialogo Configura

stampa.

Non & stato stampato
un oggetto grafico
(immagine, font di
Windows, codice a

barre ecc...).

La memoria della stampante &

esaurita.

Verificare I'opzione Cancella memoria a
stampa la prossima volta; se il problema
persiste, verificare la quantita di memoria
dedicata alle immagini (nella scheda

Immagini del driver della stampante).

La stampante non ha

abbastanza memoria.

Aumentare la quantita di memoria della
stampante aggiungendo una scheda di
memoria extra oppure aumentando la RAM
(fare riferimento al manuale del produttore
oppure chiedere al rivenditore dal quale si

€ acquistata la stampante).

Alcune stampanti non
riconoscono un oggetto se
questo si sovrappone all'area
stampabile, anche solo di

pochi millimetri.

Correggere la posizione dell'oggetto

sull'etichetta.

La stampante

termica &€ inceppata

Il supporto di stampa non & lo
stesso di quello definito nella
finestra di dialogo Imposta

pagina (carta continua o con

spazi).

Verificare che durante I'impostazione della
pagina sia stato selezionato il supporto di

stampa corretto: Continuous, With gap.
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